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Author Questionnaire 
1. Microscopy: Does your protocol demonstrate the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or similar?    NO
[bookmark: Text3]If you require a microscope but need a scope kit in order to be able to film with your own camera, please list the make and model of your microscope so that JoVE can send you a scope kit: Enter Make and Model

[bookmark: Text2]2. Software: Does the part of your protocol being filmed demonstrate software usage? YES
If Yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps. As these files are necessary for finalizing your script, please upload all screen captured video files to your project page by your script return date or as soon thereafter as possible.

3. Interview statements: Please select one.
☐ 	Interviewees self-record interview statements. 

☒ 	Interview Statements are read by JoVE's voiceover talent. 


[bookmark: Text5]3. Proposed filming date: To help JoVE process and publish your video in a timely manner, please indicate the proposed date that your group will film here: 31/03/2022 Y
DO NOT use this draft script for filming. Please wait until your script is finalized to begin the filming process.

When you are ready to submit your video files, please contact our Content Engineer, Devon Halley. 

· To ensure that your video paper meets our publication requirements, the protocol is restricted to 55 shots. 

Protocol Length
Number of Steps: 24
Number of Shots: 70 (8 shots + 58 SCs + 4 LM)

 

Introduction

1. Introductory Interview Statements

Your answers to these questions will become author interview statements, which will be incorporated into the script. Authors will memorize the statements and then deliver them on camera.
· Enter the full name of the author who will deliver the statement on camera.
· Each author should deliver no more than two statements.
· Fill out both required statements. Additional optional statements may also be selected.
· Please answer in full sentences in a style suitable for being spoken aloud. 
· Limit the length of each statement to 30 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

REQUIRED: Why is your protocol significant? OR What key questions can this method help answer? 
1.1. Doohyeon Kim: Through this protocol, the characteristics of valvular diseases that are difficult to diagnose in-vivo can be identified, and the in-vitro evaluation of the 4D flow MRI is demonstrated through this protocol.

1.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera	

REQUIRED: What is the main advantage of this technique?

1.2. Doohyeon Kim: This technique can measure time-resolved 3D velocity field of the in-vitro heart valve model. This includes retrospectively analysis of the flow rate and stroke volume.

1.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera

OPTIONAL: Do the implications of this technique extend toward the therapy (or diagnosis) of a particular disease, disability, or challenge? How so?
1.3. Hojin Ha: Based on the current technique, researchers can evaluate the accuracy and uncertainty of 4D flow MRI measurement in various valvular conditions.   

1.3.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera
OPTIONAL: Are there any specific areas of research that this method could provide insight into? OR Can this method be applied to any other systems?

1.4. Hojin Ha: We expect that this technique contributes for developing better heart valve and better diagnosis of the heart valve diseases. 

1.4.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera

OPTIONAL: How would you expect an individual who has never performed this technique to struggle? Do you have any advice to offer to somebody who is trying this technique for the first time?

1.5. Hyung Kyu Huh: 4D flow MRI measurement provides the results with Dicom medical-format images. Understanding medical images and transferring images to physical flow data would be difficult for beginners.

1.5.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera

OPTIONAL: Why is visual demonstration of this method critical?

1.6. Hyung Kyu Huh: Due to the limited access of MRI for general researchers, 4D flow MRI measurement is not widely understood from many fields. Visual demonstration of this protocol would increase the application of 4D flow MRI.

1.6.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera

Is each interview statement 30 words or fewer? ☒ Yes
Has any author been assigned more than two statements? ☒ No

Introduction of Demonstrator on Camera

Complete this statement ONLY if any of the individuals who will be demonstrating the procedure on camera will not be delivering an Introductory Interview Statement.

1.7. Hojin Ha: Demonstrating the procedure will be Doo Hyun Kim and Hyung Kyu Huh, collaborators from my laboratory. 

1.7.1. INTERVIEW: Author saying the above
1.7.2. The named demonstrator(s) looks up from workbench or desk or microscope and acknowledges the camera



Protocol
Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The one-digit numbers represent sections of the video. The text will appear as a title onscreen.
· The two-digit numbers (e.g., 2.1., 2.2.) represent steps of your protocol. The text will be recorded by JoVE's voiceover talent. 
· The three-digit numbers (e.g., 2.1.1., 2.2.2.) represent the shots that your videographer will capture in your lab. 
· Please use this draft script to help you prepare for filming day.
· If a step will take more than 10 minutes, we recommend preparing the product for that step in advance.
2. Aortic Root Model Fabrication

2.1. To begin, determine the parameter values of the aortic root, such as valve base diameter and sinus radius [1-TXT]. Run the 3-dimensional modeling software by clicking Sketch, then go to Tools Sketch Tools and go click on Sketch Picture [2].

2.1.1. WIDE: Talent in front of computer determining the parameter values of the aortic root. TEXT: Refer to the manuscript for parameter value details
2.1.2. [bookmark: _Hlk96591717][bookmark: _Hlk96591753] SCREEN: Running 3D modeling software by clicking: Sketch > Tools Sketch Tools > Sketch Picture. 00:20-00:25

Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible: https://www.jove.com/account/file-uploader?src=19364803

2.2. Sketch circles corresponding to rmax [R-maximum] and rmin [R-minimum] using the circle tool to make a sinus mode [1]. Draw a curved line of the sinus using the free curve function [2], click Loft Tool and select the sketch area for loft [3].

2.2.1. [bookmark: _Hlk96591903][bookmark: _Hlk96591864]SCREEN: Sketching circles using the circle tool. 00:26-01:28 
2.2.2. SCREEN: Drawing a curved line. 04:45-09:45 	Comment by Bhavna Kaveti: Authors: Please provide a 10 second representative clip.
2.2.3. SCREEN: Clicking on Loft Tool and selecting the sketch 13:10-14:22

2.3. Sketch additional circles on the top and bottom of the current model [1], click Extrude Tool and select the circles [2]. Set the options as 20 millimeters downward and 30 millimeters upward [3]. Make a hexahedron model in the same way [4-TXT].

2.3.1. [bookmark: _Hlk96591965]SCREEN: Sketching circles. 15:12-15:25
2.3.2. SCREEN: Clicking on Extrude Tool and select the circles. 15:25-15:35
2.3.3. SCREEN: Setting options with mentioned measurements. 15:35-16:45
2.3.4. SCREEN: Making hexahedron model. TEXT: Size: 100 mm x 100 mm x 76 mm 16:50-17:27

2.4. [bookmark: _Hlk95253878]From the Insert menu, go to Features, select Combine and click on Combine Tool [1]. Select Subtract in the property manager [2]. Select the hexahedron model and the sinus model [3]. Fabricate the final design as an acrylic model with a 5-axis CNC [C-N-C] machine per the manufacturer's instructions [4].

2.4.1. [bookmark: _Hlk96591975]SCREEN: Navigating through the sequence: Insert > Features > Combine> Combine Tool. 17:34-17:37
2.4.2. SCREEN: Selecting Subtract in the property manager 18:56-18:59
2.4.3. SCREEN: Selecting the hexahedron model and the sinus model. 19:00-19:12
2.4.4. SCREEN: Fabricating the final design

3. Valve Frame 3D Printing

3.1. Run 3D [3-D] modeling software and open a new sketch [1]. Manually draw a square and a circle in the center for the valve base [2-TXT]. Click the Extrude Tool and adjust the height of the valve base to 5 millimeters [3].

3.1.1. [bookmark: _Hlk96592217]SCREEN: Opening a new sketch in the 3D modeling software. 00:36-00:38
3.1.2. SCREEN: Drawing a square and a circle. TEXT: Dimensions: Square (100 mm x 100 mm), Circle (25 mm) 00:40-01:12
3.1.3. SCREEN: Clicking Extrude Tool and adjusting the height. 01:14-01:22

3.2. Extrude the circle with a height of 23.5 millimeters and a thickness of 3 millimeters [1]. Divide the model into 12 uniform pieces using Line Tool so that each piece has 30 degrees [2]. Select three pieces with 120 degrees intervals [3] and extrude with a height of 16.5 millimeters to make three pillars [4].

3.2.1. [bookmark: _Hlk96592235]SCREEN: Extruding the circle. 01:25-01:54
3.2.2. SCREEN: Clicking Line Tool and dividing the model. 02:04-02:17
3.2.3. SCREEN: Selecting pieces with 120 degrees intervals. 02:35-02:47
3.2.4. SCREEN: Extruding the pieces into pillars. 02:47-03:00

3.3. Click Fillet Tool and select the pillars [1]. Adjust the fillet radius at the top and bottom as 4 millimeters and 10 millimeters, respectively [2]. Save it in an STL [S-T-L] file format [3]. 3D-print the valve frame by setting infill density to 100% and using acrylonitrile butadiene styrene as fill material [4]. 


3.3.1. [bookmark: _Hlk96592244]SCREEN: Clicking Fillet Tool and selecting the pillars. 03:05-03:08
3.3.2. SCREEN: Adjusting the fillet radius. 03:08-03:52
3.3.3. SCREEN: Saving the file. 03:58-04:17
3.3.4. SCREEN: Setting the infill density and printing 05:12-05:44

4. Aortic Regurgitation Model using Expanded Polytetrafluoroethylene (ePTFE)

4.1. Run the 3D modeling software and open a new sketch [1]. Draw a horizontal line of 23 millimeters and a vertical line of 15 millimeters [2].

4.1.1. [bookmark: _Hlk96592408]SCREEN: Opening a new sketch in the 3D modeling software. 00:40-00:45
4.1.2. LAB MEDIA: 4A Video editor: Emphasize on the first image

4.2. Click 3 Point Arc Tool from the arc command manager [1]. Set two points on each end of the horizontal line and the last point on the end of the vertical line and extrude the sketch with a thickness of 5 millimeters [2]. Export the model with STL file format [3] and print it [4].

4.2.1. [bookmark: _Hlk96592433]SCREEN: Clicking on arc command manager>3 Point Arc Tool. 00:55-01:00
4.2.2. SCREEN: Setting points and extruding the sketch 01:00-01:58
4.2.3. SCREEN: Exporting the file format. 02:02-02:30
4.2.4. [bookmark: _Hlk96592525]ECU: 3D printing of design.	Comment by Bhavna Kaveti: Authors: For this, take a close-up shot of printing process.	Comment by 김두현: This step can be seen through direct shooting.

4.3. Overlap the ePTFE [E-P-T-F-E] membrane in two layers [1]. Draw three leaflet borders at intervals of 2 millimeters using the printed leaflet [2]. 

4.3.1. Talent overlapping ePTFE membrane in two layers.
4.3.2. Talent drawing leaflet borders using the printed leaflet.

4.4. Suture along the drawn lines and side borders at 1-millimeter intervals with a polyamide suture of 0.1-millimeter diameter [1]. Suture the ePTFE valve from top to bottom on the frame at 1-millimeter intervals [2]. Cut the outer side of the membrane and suture them with each other [3].

4.4.1. Talent suturing along the drawn lines and side borders using polyamide suture.
4.4.2. Talent suturing the ePTFE valve.
4.4.3. Talent cutting the outer side of the membrane and sutures them with each other.
 
4.5. Perform modifications for three different models. For the dilatation model, reduce the ratio of the designed leaflet parameters to 90% [1]. For the perforation model, make a circular hole of 2 millimeters diameter using scissors in the center of one leaflet [2]. For prolapse, fix the two commissures of the valve at a hole with a low post height [3].

4.5.1. [bookmark: _Hlk96592441]SCREEN: Reducing the ratio of the designed leaflet parameters. 03:15-03:25
4.5.2. SCREEN: Making a hole in the center of one leaflet.	Comment by 김두현: This steps are not processed using software.
4.5.3. SCREEN: Fixing the commissures of the valve at a hole.

5. MRI Scan and Parameter Selection	Comment by 김두현: Recording software can not be installed on MRI console. So I added some screenshots for this section.

5.1. Prepare the experimental system consisting Aortic models, a heart simulation pump, and MRI [1-TXT]. Set the experiment models in the MRI room and connect the pump, reservoir, and models using a silicone tube with 25 millimeters inner diameter [1]. Use a 10-centimeter-long cable and fasten the connection parts to prevent any leakage [2].

5.1.1. Talent preparing the experimental system with AR models, aortic sinus model, a heart simulation pump, and MRI. TEXT: Aortic Models: AR model, aortic sinus model	Comment by Bhavna Kaveti: Authors: Due to time-constrain, it is suggested that you have the experiment system set up previously for this shot.	Comment by 김두현: I added a figure for this step.
5.1.2. Talent connecting the pump, reservoir and models using a silicone tube.
5.1.3. Talent seals the connection parts with a cable.

5.2. Locate the model within the field of view of the MRI [1]. Perform a scout scan to observe phantom images in the coronal, axial, and sagittal views in MRI operating console monitor [2].

5.2.1. [bookmark: _Hlk96592659]SCREEN: Locating the model within the field of view of the MRI.
5.2.2. Talent observing the images of the model's coronal, axial, and sagittal views on the screen.

5.3. Locate the 2-dimensional image plane in the center of the aorta model [1]. Run a variable velocity-encoding parameter 2D phase-contrast imaging to select the most appropriate velocity encoding value for 4D flow MRI [2].

5.3.1. [bookmark: _Hlk96592666]SCREEN: Talent locating the 2D image plane.
5.3.2. SCREEN: Talent running 2D phase-contrast imaging to obtain VENC value.


5.4. Set VENC [V-E-N-C] to a 10% higher value in 4D flow MRI [1]. Enter the desired spatial resolution and the temporal resolution on the MRI console. For aortic flow, these values are 2 to 3 millimeters and 20 to 40 milliseconds [2]. Acquire data for both with and without flow using the 3 types of AR (A-R) valves and the without valve [3].

5.4.1. [bookmark: _Hlk96592672]SCREEN: Setting VENC in 4D flow MRI.
5.4.2. SCREEN: Entering values for spatial and temporal resolution on the MRI console.
5.4.3. SCREEN: Acquiring the data without flow and without valve.

6. Data Sorting and Correction

6.1. Copy raw data files from the scanner to analyze the data [1]. Sort the dicom files according to the header named series description using the Dicom sort software [2]. Click Sort Images in Dicom sort software to sort three-directional phase images and magnitude images in separate folders [3].

6.1.1. [bookmark: _Hlk96593142]SCREEN: Copying raw data files from the scanner. 	Comment by 김두현: This is not done by the software. It can be filmed by camera directly.
6.1.2. SCREEN: Sorting dicom files using Dicom sort software. 00:26-01:10
6.1.3. SCREEN: Clicking on Sort Images and saving images in separate folders. 01:25-03:16

6.2. Load magnitude image into the ITK (I-T-K)-snap software [1]. Click Brush in the ITK-snap and manually paint the internal fluid region of the phantom using the brush tool [2]. Save segmented image [3].

6.2.1. [bookmark: _Hlk96593146]SCREEN: Loading images into ITK-snap software. 15:10-15:20
6.2.2. SCREEN: Clicking on Brush and painting internal fluid region. 15:28-18:00
6.2.3. SCREEN: Saving the images. 18:52-19:10

6.3. Optionally, load both phase image data obtained with the flow on and off using MATLAB (Mat-lab) [1]. Subtract the data with the flow by the data without flow to remove background errors. Repeat this for every direction and cardiac cycle [2]. Calculate the velocity of 5D matrix phase data using a vendor-specific pixel-to-velocity equation [3-TXT].

6.3.1. [bookmark: _Hlk96593153]SCREEN: Loading phase image data for with and without flow using MATLAB. 20:40-20:45
6.3.2. SCREEN: Performing calculations to remove background errors. 21:59-22:02
6.3.3. SCREEN: Calculating the velocity of 5D matrix phase data. TEXT: Maximum pixel intensity = Selected VENC value 22:03-22:05

7. Visualization and Quantification

7.1. Load previously obtained 5D matrix velocity into flow visualization analysis software [1]. Click the Isosurface Part, and change the data type for 3D analysis by clicking the Isovolume button [2]. Drag the speed data in the variables command manager add it to the isovolume to check the velocity distribution of the model [3].

7.1.1. [bookmark: _Hlk96593268]SCREEN: Loading 5D matrix velocity into the concerned software. 00:55-01:02
7.1.2. SCREEN: Clicking on Isosurface Part > Isovolume button. 01:12-01:28
7.1.3. SCREEN: Draging the speed data and adding it to isovolume. 01:31-01:36

7.2. Click Particle Trace Emitters Tool in the main menu. Check Advanced Option for a more accurate analysis [1]. Select the desired visualization such as Streamlines or Pathlines in creation [2]. Set the values for the experiment [3]. Create and check the results over time [4].

7.2.1. [bookmark: _Hlk96593272]SCREEN: Clicking on Particle Trace Emitters Tool > Advanced Option. 02:08-02:12
7.2.2. SCREEN: Selecting visualization as Streamlines or Pathlines. 02:13-02:14
7.2.3. SCREEN: Setting the experimental values. 02:15-02:42
7.2.4. SCREEN: Checking results. 03:25-06:15 

7.3. Right-click the Particle Trace model and click the Color by [1]. Select the velocity component to color the streamline with the velocity [2]. Load the velocity data and segmented image previously obtained onto MATLAB [3]

7.3.1. [bookmark: _Hlk96593279]SCREEN: Clicking on Particle Trace model> Color by 03:04-03:08
7.3.2. SCREEN: Selecting velocity component. 03:09-03:12
7.3.3. SCREEN: Loading the velocity data and segmented image onto MATLAB. 06:30-07:08

7.4. Set the velocity outside of the segmentation region to zero by elementwise multiplying the segmented matrix data and the velocity matrix data [1]. Check if the velocity data has phase-wrapping using the Imshow function of MATLAB. Inversion of the velocity direction indicates phase-wrapping [2]. Slice the desired plane of the matrix data [3]. 	Comment by Bhavna Kaveti: Authors: How do you want the voiceover to pronounce this word?	Comment by 김두현: This word is a abbreviation of ‘image show’.
You can pronounce the word as it is.

7.4.1. [bookmark: _Hlk96593286]SCREEN: Setting the velocity outside of the segmentation region to zero. 07:28-07:40
7.4.2. SCREEN: Checking the velocity data using Imshow function of MATLAB. 07:49-08:09
7.4.3. SCREEN: Slicing the plane of the matrix data. 08:42-08:44

7.5. Sum all velocity data within the plane and multiply spatial resolution to calculate the flow rate through the plane [1]. Sum all flow rates throughout the cardiac cycle and multiply the temporal resolution to calculate the stroke volume [2].

7.5.1. [bookmark: _Hlk96593291]SCREEN: Performing calculations to obtain flow rate. 10:14-10:24
7.5.2. SCREEN: Performing calculations to obtain stroke volume. 08:47-09:04


Results
Please review this section to make sure that it accurately reflects your findings.
· Use Track Changes when making edits or revisions.
· If you would like the video to include different results, please revise this section.
· When revising, please keep the length of the voiceover below 200 words. Current word count:139. (Voiceover is the text that follows the two-digit numbers.)
· Please note that the video cannot include voiceover without an accompanying visual. 
· Notes in blue italics are for JoVE's video editor.

8. Results: Streamline Visualization, Flow Rate, and Stroke Volume Calculations

8.1. The figure shows the results of 4D flow MRI, which streamlines normal and regurgitation jets during systole and diastole. It can be observed that without a valve, an overall forward and backward flow occurred. The regurgitant jet of the dilatation model came out from the center and tended to change directions over time [1]. 	Comment by 김두현: Dilation-> Dilatation

8.1.1. LAB MEDIA: Figure 6A and 6B

8.2. Also, the forward jet was straight in all models except for the perforation model. A wall-biased jet during the systole phase occurred in this model [1]. Moreover, the perforation and prolapse model regurgitant jet leaned toward the wall [2].	Comment by Swati Madhu: “In this model” is repeating twice in this sentence. 	Comment by 김두현: This model means perforation model.

8.2.1. LAB MEDIA: Figure 6C
8.2.2. LAB MEDIA: Figure 6C and 6D

8.3. The figure shows flow rate for each valve and the forward and regurgitant volumes in a 3D plane away from the valve base. The flow rates showed different waveforms and quantities for each model. Generally, the positive percentage values indicate underestimation, while the negative percentage values represent overestimation [1].	Comment by 김두현: This sentence is more appropriate.

8.3.1. LAB MEDIA: Figure 7


Conclusion
2. [bookmark: _Hlk27388131]Conclusion Interview Statements

Below are prompts for interview statements that can be used to further emphasize the significance of your protocol. 
· Please answer one or two of the statements.
· Each statement is limited to 30 words.
· Answer the questions in full sentences; you will need to memorize and deliver the sentences as spoken interview statements during filming. 
· Indicate the full name of the author who will give each statement. 
What is the most important thing to remember when attempting this procedure? Please indicate the steps (e.g., 2.4., 2.5.) in the Protocol section of the script that this advice applies to.
2.1. Doohyeon Kim: These steps (5.1., 5.2., 5.3., 5.4., 6.2., 7.4., 7.5.) are important to proceed the protocol.[1].

2.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera (5.1., 5.2., 5.3., 5.4., 6.2., 7.4., 7.5.) 
Following this procedure, what other methods can be performed? What questions would these additional methods answer?
2.2. Doohyeon Kim: Following this protocol, researchers can fabricate various in-vitro heart valves including stenosis heart valve and regurgitation heart valve. Also hemodynamics in these valves can be investigated.

2.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera  
After its development, did this technique pave the way for researchers to explore new questions within a specific scientific field? If so, how?
2.3. [bookmark: _GoBack]Doohyeon Kim: Based on this technique, in-vitro fabrication of diseased heart valve and 4D flow MRI demonstration have been explored.

2.3.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera  
Is each interview statement 30 words or fewer? ☒ Yes
Thank you for addressing our questions. We will incorporate your answers and suggestions and send you the final script before your filming day. You will also receive detailed preparation instructions in the email accompanying the final script.
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